
 
 

SmartSensor Manager™ 
 

User Guide 
 
 

Wavetronix LLC 
380 S. Technology Ct. 

Lindon, Utah 84042 USA 
Voice:  (801) 764-0277 
Fax:  (801) 764-0208 

Web: www.wavetronix.com 
E-mail: support@wavetronix.com 

 
 

© 2007 Wavetronix LLC. All Rights Reserved. 
 

Wavetronix, SmartSensor, SmartSensor Manager, Click!, and all associated logos are trademarks of Wavetronix LLC.  All other 
product or brand names as they appear are trademarks or registered trademarks of their respective holders.   

 
Protected by U.S. Patent Nos. 6,556,916 and 6,693,557.  Other U.S. and international patents pending. 

 
The Company shall not be liable for any errors contained herein or for any damages arising out of or related to this document or the 

information contained therein, even if the Company has been advised of the possibility of such damages. 
 

This document is intended for informational and instructional purposes only.  The Company reserves the right 
to make changes in the specifications and other information contained in this document without prior 

notification. 



 

SmartSensor Manager User Guide – Wavetronix, LLC  7/16/07 2

Contents 
INTRODUCTION............................................................................................................. 4 
NEW CONNECTION ...................................................................................................... 4 

SERIAL CONNECTION ....................................................................................................... 4 
Advanced Serial Settings............................................................................................. 5 

MODEM CONNECTION...................................................................................................... 7 
Advanced Modem Settings .......................................................................................... 7 

INTERNET CONNECTION................................................................................................... 9 
FILE MENU.................................................................................................................... 10 

NEW CONNECTION......................................................................................................... 10 
PROPERTIES ................................................................................................................... 10 
SENSOR INFO ................................................................................................................. 11 
CLOSE CONNECTION ...................................................................................................... 12 
ADDRESS BOOK ............................................................................................................. 12 
DATA LOGS.................................................................................................................... 13 
EXIT............................................................................................................................... 13 

EDIT MENU.................................................................................................................... 14 
LANE CONFIGURATION .................................................................................................. 14 

AUTOMATIC CONFIGURATION ........................................................................... 14 
Edit Range Blinders .................................................................................................. 14 
Manage Gain ............................................................................................................ 15 
MANUAL CONFIGURATION.................................................................................. 16 
Adjust Lanes.............................................................................................................. 17 
Paint Lines ................................................................................................................ 18 
Remove Lines ............................................................................................................ 18 
Remove Lane............................................................................................................. 18 
Construct Roads........................................................................................................ 19 
Remove Roads........................................................................................................... 19 
Construct Barriers .................................................................................................... 19 
Remove Barriers ....................................................................................................... 19 
Reverse Direction...................................................................................................... 19 
Edit Lane Names ....................................................................................................... 20 
Saving the Configuration .......................................................................................... 21 
Undoing Manual Changes ........................................................................................ 21 
Restarting Lane Configuration ................................................................................. 21 
Exiting Lane Configuration ...................................................................................... 22 

SENSOR SETTINGS.......................................................................................................... 23 
SENSOR DATE & TIME................................................................................................... 26 
OPERATING MODE ......................................................................................................... 27 

VIEW MENU .................................................................................................................. 28 
TRAFFIC (EVENT DATA) AND INTERVAL DATA.............................................................. 28 

DATA COLLECTION MENU...................................................................................... 29 
SETUP ............................................................................................................................ 29 
DOWNLOAD ................................................................................................................... 30 

TOOLS MENU................................................................................................................ 31 
HYPERTERMINAL ........................................................................................................... 31 



 

SmartSensor Manager User Guide – Wavetronix, LLC  7/16/07 3

FIRMWARE UPLOAD....................................................................................................... 31 
HELP MENU .................................................................................................................. 32 

TABLE OF CONTENTS ..................................................................................................... 32 
ABOUT SMARTSENSOR MANAGER................................................................................. 34 

COMMUNICATION ERROR ...................................................................................... 36 



 

SmartSensor Manager User Guide – Wavetronix, LLC  7/16/07 4

Introduction 
SmartSensor Manager brings increased user-friendliness and improved functionality to 
the ITS industry’s only patented auto-configuration and auto-calibration process.  The 
new features found in SmartSensor Manager 2.2 include a redesigned “New Connection” 
page, a reorganized menu bar with new options, and expanded help capabilities to assist 
users in navigating SmartSensor Manager and performing basic operations. 
 
 

New Connection 
Once the user opens the SmartSensor Manager application, the “New Connection” page 
automatically appears and displays the three connection options available through 
SmartSensor Manager.  Choose the desired method of connection and click OK.  The 
Serial (COM Port) radio button will be selected by default (see Figure 1). 
 

 
Figure 1 – New Connection Page 

 
Clicking OK opens a connection page unique to each connection option.  Each 
connection page contains three function buttons:  Connect, Advanced, and Cancel.  The 
advanced functions for each connection option are specific for each option. 
 
 

Serial Connection   
Connect the SmartSensor directly to a computer’s serial Com port and a message will 
appear near the top of the page that says: 
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“Click <Connect> to continue using current settings, or click <Advanced> to adjust the 
settings…” (see Figure 2). 
 

 
Figure 2 – Serial Connection 

 
The three action buttons appear near the bottom of the page.  The Cancel button cancels 
the action and returns the user to the “New Connection” page. 
 
A message bar at the bottom, identified by the  icon, displays the serial settings being 
used for this connection.  If the default settings are used, then the message bar will 
display the following: 
 

COM – Auto; Baud – Auto; ID – Simple; Synchronize Yes; Wait – 0 
 

Advanced Serial Settings 
Advanced settings can be found, and changed, by clicking the Advanced button (see 
Figure 3). 
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Figure 3 – Advanced Connection Settings 

 
• PC Com Port Settings – To manually select com port and baud rate settings, 

click the Specify PC com port & baud rate settings radio button and this will 
activate the “Port #” and “Baud Rate (bps)” drop down lists. 

• Additional Response Wait Time – By default, SmartSensor Manager waits a 
few milliseconds to receive a response from the sensor before timing out and 
displaying a communication error message.  Users can add additional seconds to 
the response wait time to ensure that the connection to the sensor is properly 
made.  Click the Use an additional: check box to activate the “milliseconds” text 
box and enter the number of additional milliseconds SmartSensor Manager should 
wait for a response from the sensor. 

• SmartSensor Network Protocol – Identify sensors that are part of a multidrop 
network by clicking the appropriate radio button.  “Simple Protocol” refers to 
sensors that are not part of a multidrop environment; if the sensor is part of a 
multidrop network, SmartSensor Manager can either auto-detect the multidrop ID, 
or the user can enter the four-digit ID.  Clicking the Use Multidrop 
Protocol…Connect Directly to ID: radio button will activate the text box. 

• Time Synchronization – Click the check box to have SmartSensor automatically 
synchronize with the PC clock. 

 
Click on the check box at the bottom of the page to use the new settings as default. Click 
OK to save settings or Cancel to return to default; both buttons will return the user to the 
Serial Connection page.  The new settings will be reflected in the message bar at the 
bottom of the page.  
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Modem Connection  
Clicking the Modem (Phone #) radio button will connect the user to the SmartSensor 
using a modem.  The “Modem Connection” page has a text box in which users enter the 
phone number for the sensor’s modem (see Figure 4).  The phone book icon to the right 
of this box allows users to browse for numbers previously saved in the SmartSensor 
Manager Address Book. 
 

 
Figure 4 – Modem Connection 

 
Click the Dial Manually check box to dial the number manually.  Once the number is 
entered, click Dial to make a connection.  Click Cancel to stop the action and return to 
the New Connection page. 
 
The message bar at the bottom of the page, identified by the  icon, shows the modem 
settings being used.  If the default settings are used, the message bar will display the 
following: 
 

ID – Simple; Synchronize Yes; Wait – 0. 
 

Advanced Modem Settings 
The following settings are part of the modem connection’s advanced functions and can be 
found by clicking the Advanced button (see Figure 5): 
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Figure 5 – Advanced Modem Settings 

   
• Local Modem Settings – The initialization string and Auto-find command can be 

entered in the Local Modem Settings section.  The Restore Defaults button will 
return the functions to their default settings.   

• Additional Response Wait Time – By default, SmartSensor Manager waits a 
few milliseconds to receive a response from the sensor before timing out and 
displaying a communication error message.  Users can add additional seconds to 
the response wait time to ensure that the connection to the sensor is properly 
made.  Click the Use an additional: check box to activate the “milliseconds” text 
box and enter the number of additional milliseconds SmartSensor Manager should 
wait for a response from the sensor.   

• SmartSensor Network Protocol – Identify sensors that are part of a multidrop 
network by clicking the appropriate radio button.  “Simple Protocol” refers to 
sensors that are not part of a multidrop environment; if the sensor is part of a 
multidrop network, SmartSensor Manager can either auto-detect the multidrop ID, 
or the user can enter the four-digit ID.  Clicking the Use Multidrop 
Protocol…Connect Directly to ID: radio button will activate the text box. 

• Time Synchronization – Click the check box to have SmartSensor automatically 
synchronize with the PC clock.  

 
Click the check box near the bottom of the page to use the new settings as default.  The 
OK button saves the new settings and the Cancel button cancels the changes; both 
buttons return the user to the Modem Connection page.  The new settings will be 
displayed in the message bar at the bottom of the page. 
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Internet Connection   
The Internet connection option will connect to the SmartSensor using the sensor’s IP 
address.  The “Internet Connection” page has two text boxes in which users enter the 
sensor IP address and port number (see Figure 6).   
 

 
Figure 6 – Internet Connection 

 

The  icon allows users to browse through previously saved addresses in the SSM 
address book. 
 
The Connect button does not become active until both IP address and Port number boxes 
are filled.  The current settings for the Internet connection will be displayed in the 
message bar at the bottom.  The Internet Connection’s advanced functions are identical to 
the advanced functions of the Modem connection and can be found by clicking the 
Advanced button. 
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File Menu 
The “Menu” bar makes it easier to navigate through SmartSensor Manager and to locate 
specific SSM functions (see Figure 7). 
 

 
Figure 7 – Menu Bar 

 
The “File” menu allows you to navigate to each connection page, view connection 
properties and sensor information, and access the Address Book and Data Logs. 
 

New Connection  
The “New Connection” list allows the user to connect to the Serial, Modem or Internet 
connection pages from any spot in SmartSensor Manager (see Figure 8). 
 

 
Figure 8 – File Menu 

 

Properties   
The “Properties” option displays the following properties of the current connection (see 
Figure 9):   
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Figure 9 – Current Connection Properties 

 
• The type of connection (Serial, Modem, or Internet).  This will say, 

“Disconnected” if SmartSensor Manager is not currently connected.   
• The “Port” displays the Com port and baud rate settings. 
• The “Protocol” displays whether this is a multidrop network sensor or a simple 

sensor network. 
• The “Response Wait Time” shows the wait time information for each sensor.  The 

first box shows the number of milliseconds SmartSensor Manager will 
automatically wait for a response from a specific sensor.  SmartSensor Manager 
determines this number by averaging recent sensor response times, so this number 
may fluctuate slightly when the Re-calculate button is clicked. 

• The second box shows the number of additional seconds the user has added, and 
the third box shows the total number of seconds SSM will wait for a response.  
Click the Save as Default button to save the new settings as default. 

 
Click OK to close the window. 
 

Sensor Info 
The “Sensor Info” option opens the Sensor Information page, which displays the 
properties unique to each sensor (see Figure 10).  Although the information cannot be 
edited, there must be an active connection to view the “Sensor Info” page.  The 
“Identification” section shows the sensor’s Serial Number, Description, Location, Sensor 
ID and Serial Interface; the “Firmware Versions” section shows which versions of “DSP” 
(Digital Field Processing) and “FPGA” (Field Programmable Gain Amplifier) on which 
the sensor is operating. 
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Figure 10 – Sensor Information 

 

Close Connection 
The “Close Connection” option closes the connection to the sensor. 
 

Address Book  
The “Address Book” allows the user to create a new address book file or open an existing 
file.  The “Open” option is divided into separate “Modem” and “Internet” entries.  Both 
“New” and “Open” options display a directory box to either save the file in a specific 
location or locate an existing file (see Figure 11). 
  

 
Figure 11 – Address Book 
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Data Logs 
The “Data Logs” option allows users to create new “Download,” “Event” or “Interval” 
logs, or open existing logs.  “Event” and “Interval” logs are identical to the logs 
generated by earlier versions of SmartSensor Manager.  Download logs are similar to 
Interval logs, but Interval logs are generated in real time through an active sensor 
connection while Download logs are generated when data stored in the sensor’s Flash 
memory is downloaded to SmartSensor Manager. 
 

Exit   
The “Exit” option closes SmartSensor Manager.  
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Edit Menu 
The Edit menu allows the user to configure the sensor, edit sensor settings and the sensor 
date and time, and change the operating mode (see Figure 12). 
 

 
Figure 12 – Edit Menu 

 

Lane Configuration   
The “Lane Configuration” option opens the LaneSmart function of SmartSensor 
Manager.  This allows the user to perform automatic configuration and provides all the 
tools necessary to perform manual, customized configurations.   
 

AUTOMATIC CONFIGURATION 
Follow the steps below to automatically configure the SmartSensor: 

1. Select Lane Configuration from the “Edit” menu.   
2. Once the “Lane Configuration” page opens, click on the Automatic button.  
3. Confirm the configuration restart by clicking Yes.  SmartSensor Manager will 

automatically begin detecting and configuring lanes, and the screen will show a 
visual depiction of the lanes and vehicle detections in real-time. 

4. After the lanes have been detected and configured correctly, save the 
configuration by clicking the Finished button.  The time required for 
configuration depends on the volume of traffic present in the lanes, but is 
typically only a few minutes.   

 
If SmartSensor Manager is unable to correctly configure due to extraneous or missing 
lanes, use “Manual Configuration” to adjust.   
 
NOTE:  Free-flowing traffic is required for proper configuration. 
 

Edit Range Blinders 
Using Range Blinders will narrow the search area of the automatic lane configuration 
process (range blinders have no effect in Manual Configuration mode).  Use the steps 
below to successfully edit the range blinders: 
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1. Click the Range Blinders button.  Red bars (range blinders) will appear at the top 
and bottom of the roadway display and any previously displayed roadways will be 
cleared. 

2. Left-click on one of the range blinders and drag its edge to the desired range 
(refer to the range markers on the left side of the screen). 

3. Repeat Step 2 for the other range blinder if necessary. 
4. Click the Restart button to apply the range blinders; otherwise, click the Range 

Blinders button again to disable the range blinders and use the default ranges.  
When the range blinders are applied, they will turn from a red color to a dark 
khaki color.   

5. After the lanes are detected and configured correctly, save the configuration by 
clicking the Finished button.  After clicking the Finished button, the 
SmartSensor will begin storing vehicle data.  The time required for configuration 
depends on the volume of traffic present in the lanes, but is typically only a few 
minutes. 

 
NOTE:  After clicking the Restart button, detected vehicles (represented by moving 
blue rectangles) will be displayed only if a range blinder does not cover the lane center.  
If the edge of a range blinder lies between two lanes of the same road, some manual 
adjustment of the gray line (usually reserved to indicate a road shoulder) may need to be 
made.  The edge of the road shown in the display is really a lane divider.  
 
NOTE:  Free-flowing traffic is required for proper configuration. 
 
If SmartSensor Manager is unable to correctly configure, due to extraneous or missing 
lanes, use “Manual Mode” to make the necessary adjustments.    
 
NOTE:  After clicking the Finished button, wait for one minute before turning off the 
sensor.  During this time the sensor is completing adjustments of the configuration 
thresholds.  Typically this is not a problem because verification may be needed in 
“Traffic View” after clicking Finished.  The verification process will normally be longer 
than one minute. 
 

Manage Gain 
During the automatic configuration process, the sensor’s gain is automatically adjusted in 
order to best process the radar signal at that particular installation site.  In some locations, 
the reflections from vehicles may be stronger than in other locations and the gain will 
need to be lowered in order to optimize detection accuracy.   
 
For the gain to be optimally adjusted by the automatic process, the sensor needs to be: 

• Aligned almost exactly perpendicular to all the lanes of the roadway. 
• Still configuring while several large vehicles (that return strong reflections) pass 

through the beam in the lanes closest to the sensor. 
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In some locations, and at particular times of the day, it may be difficult to meet both of 
these requirements.  In these cases, click the Manage Gain button to change the starting 
point of the automatic gain adjustment process.  The default starting point is a gain value 
of “5.”  The adjustment process never increases the gain value; it only decreases it.  So 
the starting point is also the “Maximum Gain Value.”  
 
A new starting point will only be applied after clicking the Restart button.  During the 
automatic configuration process, the sensor's current gain value is displayed in the status 
bar at the bottom of the screen.      
 
No adjustments to the gain can be made once the configuration is saved to the sensor.  
However, the detection thresholds configured for the sensor during the automatic 
configuration process are based upon the current level of the gain and will continue to 
adapt for up to one minute after clicking the Finished button.    
 
NOTE:  The default starting point of “5” is also the largest starting point allowed.  If the 
user enters a value larger than “5,” the default starting point of “5” will be used.  If the 
user is managing the gain, they will typically change the starting point to a “3” or “4.” 
 
 

MANUAL CONFIGURATION   
If the sensor is unable to automatically configure to satisfaction, it can be manually 
configured by drawing roads, lane dividers and barriers.  With the “Lane Configuration” 
page open, select the Manual button and the tool buttons in the toolbar on the right of the 
screen will be activated (see Figure 13).  To change the configuration, click the 
appropriate button, move the cursor over the window showing roads and vehicles, and 
make the changes. 
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Figure 13 – Automatic (L) and Manual (R) Configuration Modes 

 

Adjust Lanes 
The Adjust Lanes button allows the user to click and hold the mouse cursor on a 
shoulder (gray line), lane divider (white line), or lane center (pink line) and drag it to a 
desired position (see Figure 14).  When the cursor is positioned over a draggable line, it 
will change from an arrow to a hand.   
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Figure 14 – Manual Configuration Tools 

 
Lane centers (pink lines) only appear when the cursor is directly over a lane.  To adjust 
this lane center, click and hold the left mouse button and move the line up or down on the 
screen within the area between the shoulders.  Shoulders, dividers, and centers cannot be 
dragged past each other. 
 

Paint Lines 
The Paint Lines button allows the user to insert lane dividers in paved (black) areas.  The 
mouse cursor will change from an arrow to a hand when it is directly over a location 
where it is possible to paint a lane divider.  Once the cursor changes to a hand, click the 
left mouse button and a white line will appear. 
 

Remove Lines 
To remove a lane divider, click on the Remove Lines button, select the white line to be 
removed (the cursor will change to a hand) and click the left mouse button. 
 

Remove Lane 
To remove a lane, click on the Remove Lane button and the hand icon will appear as the 
user moves the mouse over the lane to be removed.  When the hand icon is in position, 
click on the left mouse button.  If the wrong lane was selected, or if the lane needs to be 
reinserted, simply click the Undo button. 
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Construct Roads 
To insert a new road consisting of a shoulder-center-shoulder, click on the Construct 
Roads button and select a location anywhere in the background (khaki colored) area.  
The hand icon will appear if the cursor is positioned directly over a location where a road 
can be constructed.  Click the left mouse button to draw the road.   
 
Because new roads are initially drawn with an upper-shoulder line, a centerline, and a 
lower-shoulder line, it is usually necessary that the user adjust the road to the desired 
width using the “Adjust Lanes” function. 
 

Remove Roads 
The Remove Roads button allows the user to remove an entire road.  To remove a road, 
including all lanes, click on the Remove Roads button, select the road to be removed and 
click the left mouse button. 
 

Construct Barriers 
A “barrier” or “median” is defined as two adjacent shoulders or two shoulders with only 
background area in between them.  Constructing a barrier is essentially the act of dividing 
a single road into two separate roads.   
 
To construct a barrier or median, click on the Construct Barriers button and select the 
paved area where a barrier is desired.  Click on the left mouse button and the barrier will 
appear.  Initially, the new barrier will only be two shoulder lines wide; to widen the 
barrier, use the “Adjust Lanes” feature. 
 

Remove Barriers 
Removing a barrier will convert two roads into a single road.  To remove a barrier, click 
on the Remove Barrier button and select the area between two roads. 
 

Reverse Direction 
The current version of SmartSensor does not determine the direction traffic travels in 
each lane.  However, it is useful to have the direction of the events in SmartSensor 
Manager reflect the actual direction of travel.  Changing the lane direction only affects 
the SmartSensor Manager display and is beneficial for verifying performance.  
 
The Reverse Direction button enables the user to change the direction the vehicle events 
travel across the screen in each lane.  To change the direction of travel across the screen, 
click the Reverse Direction button, move the cursor over the lane of interest and click 
the left mouse button.  While the cursor is over a lane, a tiny arrow will appear below the 
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hand to indicate the current direction.  When changing the direction, the tiny arrow 
reverses direction to verify that the change occurred (see Figure 15).   
 

 
Figure 15 – Reverse Direction Tool 

 

Edit Lane Names 
By default, the SmartSensor labels the lanes it configures from “Lane1” up to “Lane8,” 
where “Lane1” is the lane located closest to the sensor.  The user can assign different 
lane numbers by clicking the Edit Lane Names button, which causes an “Edit Lane 
Names” window to appear (see Figure 16).  The user will now be able to enter up to eight 
(8) alphanumeric characters for each lane configured.  SmartSensor reports data per lane 
according to their labels.     
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Figure 16 – Edit Lane Names 

 

Saving the Configuration 
To retain the changes to the configuration, the user must save it to SmartSensor’s flash 
memory, which is done by clicking the Update button located below the manual 
configuration tools (see Figure 17).  After saving the configuration, the user will remain 
in the “Lane Configuration” page so that any manual changes made may be viewed and 
easily changed if necessary. 
 

 
Figure 17 – Update, Undo and Restart Buttons 

 

Undoing Manual Changes 
The user can undo changes that have not been updated to the SmartSensor by clicking the 
Undo button at the bottom of the “Lane Configuration” window.  This feature brings 
back the last saved configuration from the sensor, effectively undoing any unsaved 
changes that were made. 
 

Restarting Lane Configuration 
To completely erase the SmartSensor’s current configuration and restart the “Lane 
Configuration” routine, click the Restart button (the user can be in either Manual or 
Automatic mode to do this). 
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By clicking Restart while in Manual Mode, the changes made will be undone and 
SmartSensor Manager will change to Automatic Mode; by clicking Restart while in 
Automatic Mode, changes made will be undone, but SmartSensor Manager will stay in 
Automatic Mode.  Clicking the Restart button will cause the window below to appear; 
click Yes to continue or No to return to the previous configuration (see Figure 18).     
 

 
Figure 18 – Restart Confirmation Dialogue Box 

 

Exiting Lane Configuration 
After all the changes have been made in Lane Configuration, and you are ready to save 
and exit the “Lane Configuration” screen, click the Finished button located at the bottom 
right of the screen.  Clicking on the Finished button will cause a window to appear 
indicating that the changes are being saved to the SmartSensor.  After the changes have 
been saved, SmartSensor Manager will automatically change from “Lane Configuration” 
to the “Traffic/Event Data” mode. 
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Sensor Settings   
The “Sensor Settings” option allows the user to change the sensor settings.  If no sensor 
connection is active, selecting this will open a directory box allowing users to find 
settings that are saved on the computer.  
 
The Sensor Settings page is divided into three sections:  “General,” “Communication” 
and “Data Collection.” 
 
The General tab allows the user to edit the following settings (see Figure 19): 
 

 
Figure 19 – General Tab 

 
• SmartSensor (Multidrop) ID 
• RTMS ID 
• Sensor Description – (see the “Sensor Info” screen) 
• Sensor Location – (see the “Sensor Info” screen) 
• Sensor Orientation – Use the drop down list to select the direction the sensor is 

facing. 
• Measurement Units – This allows users to select between English and Metric 

measurements.  Metric units are entered in decimeters so that the Metric and 
English units can be converted more accurately. 

• RF Channel – This allows users to assign specific RF channels to sensors that are 
located in close proximity to prevent the sensors from interfering with each other. 
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The “Communication” tab allow users to change the following settings (see Figure 20):  
 

 
Figure 20 – Communications Tab 

 
• Baud Rates 
• Sensor communication Response Delays in milliseconds.  

NOTE:  This is especially important when the sensor is connected to 
communication equipment that cannot handle the speed with which the sensor 
responds to messages. 

• Advanced Communication Registers – Select Enable from the Simple Protocol 
drop down list for sensors that are not part of multidrop networks. 

• Flow Control – Enable Flow Control for communication equipment that requires 
handshaking by selecting RTS/CTS from the drop down list. 

• Data Pushing for data collection. 
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The “Data Collection” tab allows users to change the following settings (see Figure 21): 
 

 
Figure 21 – Data Collection Tab 

 
• Interval Data – The interval of time (in seconds) that traffic data is aggregated 

(minimum interval is “5” seconds). 
Interval data is stored directly into the sensor’s SRAM memory, which is 
extremely volatile and will not persist after a power-cycle.  The number of 
intervals is limited to “246.”   
Users can also tell the sensor to move the interval from SRAM to the sensor’s 
Flash memory by clicking the Store in Flash Memory check box.  This protects 
the data because Flash memory persists after power cycles.  The capacity in Flash 
is ten times greater than SRAM and once buffer is filled, the data won’t be 
overwritten because SmartSensor’s Flash storage is now a front-loading memory 
bin versus a cyclical bin.  Once the Flash memory is full, no more data can be 
written to it until the data is downloaded or erased. 
If the “Store in Flash Memory” box is not checked, the Interval data will remain 
in SRAM until it is overwritten. 

• Vehicle Classification – Users can customize vehicle classifications by length.  
Enter the maximum length amounts for “Small” and “Medium” class vehicles in 
the active text boxes and SmartSensor Manager will automatically determine the 
minimum lengths. 

• Lane Setup – The Lane Setup section allows you to change specific lane 
information such as lane name, direction of travel, scale occupancy (loop size), 
and scale speed (loop spacing) for tuning the sensor.  These boxes feature scroll 
arrows that enable the user to change the values incrementally.  Also, the Show 
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Loop Values button allows users to toggle quickly between the Loop Values and 
the data affected by each loop function.   

• Default Loop Size & Spacing – Users may enter default values which, when 
applied, will automatically update the information for each lane. 

 

Sensor Date & Time  
The “Sensor Date & Time” option will open a screen allowing the user to change the 
SmartSensor’s date and time (see Figure 22). 
 

 
Figure 22 – Sensor Date and Time 

 
Change the date by selecting the correct date from the drop down lists (month, day, and 
year) or use the calendar to scroll to the correct date.  Change the time by selecting the 
correct time (hour, minutes, and seconds) from the drop down lists.   
 
Click the check box below the calendar to automatically adjust for local computer time 
and daylight savings time settings; click the check box at the bottom of the page to 
automatically synchronize sensor to PC UTC time every <user defined> minutes. 
 
The “Sensor Date & Time” page includes the following three function buttons:   

• The  button performs a one-time synch of the sensor to the PC’s UTC time.  

• The  button saves the new settings. 

• The  button undoes the changes. 
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Operating Mode   
The “Operating Mode” option allows the user to switch between “Side Fire” and 
“Forward Fire” operation modes.  SmartSensor must be installed in a forward fire 
position for the forward fire configuration tools to work properly. 
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View Menu 
The “View” menu allows the user to view sensor data (see Figure 23). 
 

 
Figure 23 – View Menu 

 

Traffic (Event Data) and Interval Data 
The “Traffic (Event Data)” and “Interval Data” allows the user to select a real-time view 
of collected data.  The Traffic (Event Data) option opens the “Traffic View” screen, 
which shows the saved lane configuration with detected vehicle representations; the 
Interval Data option shows the numerical data gathered per lane by that sensor. 
 
Both screens feature a toggle button in the lower-right corner.  On the “Traffic (Event 
Data)” screen, this button is marked Interval Data and allows users to go directly to 
“Interval Data” without using the menu.  On the “Interval Data” screen, this button is 
marked Event Data and takes the user to “Traffic View.” 
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Data Collection Menu 
The Data Collection menu allows the user to collect and analyze data (see Figure 24). 
 

 
Figure 24 – Data Collection Menu 

 

Setup 
The user can easily set-up the SmartSensor for use in studies.  The screen below shows 
the two-step process for setting up the sensor (see Figure 25): 
 

 
Figure 25 – Data Collection Setup 

 
• Step 1 verifies the interval (bin) size, which the user can determine by entering 

the interval in seconds in the text box causing a new “Flash Storage Time” to be 
displayed. 

• Step 2 asks the user to click the Start button to begin the study.  Check marks 
will automatically appear in the boxes as each set-up task in the list is completed. 
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Download 
To download interval data stored on the sensor, click the Browse button to either create a 
new data Download file log or locate an existing Download file log (see Figure 26).  
Select the type of download to perform (an incremental download of all data stored since 
the last download, which will be displayed in format “yyyy-mm-dd hh:mm:ss”; or a full 
download of all the data on the sensor) and click the Download button. 
 

 
Figure 26 – Data Collection Download 

 
The Download section also allows the user to manage the sensor’s “Interval Data 
Storage.”  Click on View Storage Space to see how much space is used or available; 
click on Erase Stored Data to clear the sensor’s memory and start fresh.  If the storage 
space is full, data must be downloaded or erased in order for the study to continue. 
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Tools Menu 
The “Tools” menu allows the user to view and send messages, as well as upload firmware 
(see Figure 27). 
 

 
Figure 27 – Tools Menu 

 

Hyperterminal   
Hyperterminal allows the user to send message requests and view message responses for 
any commands in either “Simple” or “Multidrop” protocols.  Enter the request in the 
“Command Line” located near the top of the screen.  Click on the appropriate radio 
button to either transmit information all at once after the Enter key on the computer 
keyboard is pressed or to auto transmit each character as they are typed.  The user may 
also use binary mode to verify operation of binary protocols supported by SmartSensor 
by clicking the Binary Mode button. 
 

Firmware Upload   
The user can perform a firmware upload by clicking the appropriate radio button for 
either “DSP” or “FPGA” firmware.  Click the Browse button to locate the firmware 
stored on your computer; click the UPLOAD button to transfer the firmware to the 
sensor. 
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Help Menu 
The “Help” menu contains a Table of Contents as well as additional information about 
SmartSensor Manager (see Figure 28). 
 

 
Figure 28 – Help Menu 

 

Table of Contents   
The “Table of Contents” option opens SmartSensor Manager’s Table of Contents to find 
information on performing different SSM functions and operations.  
 
SmartSensor Manager has the following help capabilities to assist users with information 
about different SSM functions and operations: 

• Many pages in SmartSensor Manager have a  button in the top right corner of 
the page, which opens a help page with information specific to that page.   

• The user can get simple text information by placing the cursor arrow over 
different buttons.  After a few seconds, a small yellow text box will appear that 
gives a brief description of the functions of that button. 

• The user can get detailed help by going to Help > Table of Contents and finding 
the desired topic from the list.  The list is divided into the following three 
columns (see Figure 29): 
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Figure 29 – Table of Contents Page 

 
1. Topic – Lists the available topics in order of importance. 
2. Availability – Shows whether the information is available or not. 
3. Type – Shows the type of information contained on the “Help” page.  Tutorial 

provides overview information; Context Sensitive is information specific to a 
particular function or operation. 

 
Open the desired information from the Table of Contents by either double clicking on the 
subject in the list, or by highlighting the item and clicking the Display Help Topic button 
(see Figure 30).   
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Figure 30 – Help Information 

 
Users can access the “Table of Contents” page from anywhere in SmartSensor Manager; 
an active sensor connection is not needed.  This enables the user to get help information 
at any time, especially if information about connecting to a sensor is needed. 
 

About SmartSensor Manager  
The “About SmartSensor Manager” option opens the “About” page which contains the 
SmartSensor Manager version name and copyright information (see Figure 31).  
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Figure 31 – About SmartSensor Manager 
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Communication Error 
The “Communication Error” screen will appear if there is a communication error between 
the sensor and SmartSensor Manager.  If an error occurs, the “Communication Error” 
screen will give the user the following options (see Figure 32): 

• Retry – Tells SSM to try and communicate with the sensor again. 
• Cancel – Stops the current operation as well as other operations that may be in 

process. 
• Details – Shows error details. 

 

 
Figure 32 – Communication Error 

 
If the user retries two or more times to communicate with the sensor and it still doesn’t 
work, the problem can often be fixed by editing the “Additional Response Wait Time.” 
Click the Details button and this will open an additional page that shows the following 
information specific to this problem (see Figure 33): 
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Figure 33 – Communication Error with Details screen 

 
• Operation – The operation the user is trying to accomplish. 
• Response Error – The response error the user has encountered. 
• Error Code – The error code related to the specific error. 
• Reliability – The percentage of communication attempts that were successfully 

completed. 
• Automatic Retries – The number of retries the SSM automatically attempts 

before showing the communication error screen. 
• Response Timeout – The total number of milliseconds that SSM waited before 

timing out the requested operation. 
 

 
 


